Welcome to Right Fielder!

Welcome to Right Fielder!

Right Fielder simplifies data processing by taking poorly organized databases without
descriptive field names and inconsistent structure and producing a properly organized and
structured list with data assigned to the proper field ready to be included in your mailing
lists. Right Fielder also recognizes and flags suspected foreign addresses. Process up to
1 million records per hour.

System Requirements
Right Fielder requires:
e Microsoft® Windows 98, Me, NT, 2000, 2003, XP or Vista.
¢ Intel Pentium IlI® or better.
* 64 MB of RAM minimum. 128 MB of RAM is recommended.
* 10 MB of available hard disk space.

Installation

To install from a CD:
1. Insert the installation disk into your CD-ROM drive.

2. The installation program should start automatically and the install program will
appear.

3. Follow the on-screen instructions.

If installation does not start automatically:
1. Click the Start button on the task bar.
Click Run...
Type d:\setup.exe (where d: is your CD-ROM drive letter).
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Follow the on-screen instructions.

Open a File

RightFielder can open dBase files (*.dbf) and multiple formats of text files.
1. To open afile, click the File menu and select Open Database...

2. Right Fielder displays the Open Database... dialog.



Right Fielder Quick Start Guide

3. Select the database file to be processed and click Open.

Open Database... e
Look in: |l’f} Demos j |‘j( Ed-

@ demorf

File name: |

Fies of type: |DBase Il ~dbf) =l Cancel

Drive C statistics:
Tatal: 746 GB
Used: 51.1 GB

Free: 234 GB

4. If there is a setup file with the same name as the database file in the same folder,
Right Fielder will ask if you want to open the existing file. Click Yes to open the
existing setup file.
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New Setup

The setup file instructs Right Fielder how handle data in the input file, which fields to read,
which to write and which to ignore.

To create a new setup:

1. Click the File menu and select New Setup....

] Options ]
Input Fields Output Fields 8 8
Fedt:[F1 v] Sz Sz

) Mamel: - Address3: hd
Field 2: |F2 -
. Mamez: - City: -
Field 2: |F3 -
. Mame3: - State: -
Field 4: |F4 -
. Title/Deptl: - Zip/PC: -
Field &: |F& hd
Field & ’m Title/Dept2: - Zip+d: -
ield 6: -
Field 7 [F7 Company: - Country: -
ield 7: -

C 2 - Phonel: -
Field 8 | Fa hd ompan o

. Address1: - FhoneZ: ’—L| ’_
Field 3 -
Field 10: Sl e [~ | @ Profile Database...
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New Setup

2. Right Fielder displays the Input/Output Fields tab of Setup dialog.

By default, Right Fielder selects the existing fields in the database in order the
order they appear as the Input Fields. You can exclude certain fields from
processing and change the order using these dropdown lists.

4. Once you have selected your input fields, click the Profile Database... button to
see Right Fielder’s best estimate of the type of information contained in the
current database.

5. Select the output fields using the second and third column of dropdown lists. If you
are working with dBase files, you can enter names for each field and in the boxes
and these fields will be created when Right Fielder processes the file.

6. If you select existing fields, Right Fielder will enter the size in characters of this
field in the Size box. If you are creating new fields, you must enter a number
greater than zero in this box.

Setup Options

The Setup Option tab gives more precise control over how Right Fielder handles data from
the input fields and writes it back to the output field.

Input/Output Fields ~ Options |

Options
Busineszs/Residental Mix: Detect Blank Output Fields:
" Business [~ Mamel I~ Address2
" Residential [~ Mame2 I~ Address3
+ Both [ Mame3 Iv City
Address Sequencing: Address Justification: ||: H:E::BED:; ||g g_ta;;.-"tl::'rov
" Primary above Secondary " Top — EI 2 9D1 - Z!D 4
+ Primary below Secondary + Bottom — Eompany — P+
" Maone [match input) ampany2 Cauntry
[~ Address1 [~ Phonel
[~ "% Indicates: ™ Phone2

I Discard Unidentified Fields

™ Always Move Last Line to: Size:
Error Code: |ERR -

Help

1. Select the best Residential / Business Mix for the current database. This
determines how Right Fielder handles records where it's ambiguous whether the
address is a business or residence.

2. Select the Address Sequencing option. This controls which is written back first,
the secondary address or the street address. If you select Primary Below
Secondary, for example, Right Fielder will write the suite number to the Address1
field and the street address to Address2.
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3. Select the Address Justification option. This controls which address field will
always written to during processing. For example, if you select three address
fields and select Top, Address1 will always be used and other address data, if any,
will be written to Address2 and if necessary, Address3.

If you were to select Bottom, then the last address field will always be the highest
one configured on the Input/Output Fields tab. In other words if you configure
three address fields and a given record has two addrss fields, then the address
data will be written to Address2 and Address3 while Address1 is left blank.

If you select Primary below Secondary Address Sequencing and Bottom
Address Justification, this will always place the street address in the last address
field that you configure.

Input/Output Fields lOpﬁong ]
Input Fields Output Fields

Feldi:[F1 =] Size Size
Field 2: [F2 NameT: [NAME1 v|[30 Addessz [sDDRY  ~|[40
ield 2 =

Name2: [NaMEZ  +|[30 Ciy: [Ty = e
Field 3 [F2 > ame ity [30

Fietd 4 [F4 Mame3: |MAMES |30 State: |STATE -2
ield 4: -
. Title/Deptl: [TITLE_DEP1 |30 Zip/PC: |ZIP ~||6
Field &: |F& hd
Field &: [Fe Title/Dept2: |TITLE_DEFZ - (|30 Zip+d: [PLUS4 ~||4
ield 6: -
Field 7 [F7 Companyl: |[COMPANYT |40 Country: [COUNTRY = |20
ield 7: -
Field & [Fg Company2: |COMPANYZ |40 Phonel: |PHOMET - |15
eld 8 -
e ’—_| Address1: |ADDR1 |40 Phone: |PHONEZ - |15
ield 3: -

Field 10: —{|| Addess2 [s0DR2  v[[40 @ Profile Database...

Help
Type the [optional] fieldname that will receive the third Output Address.

In the Setup shown above, the street address would be placed in ADDR3 and the
secondary, if any, would be in ADDR2. This setup ensures that the street address
always appears in the same field.

4. Check the “&” Indicates box if an ampersand character (&) is typically found in
the Name, Department/Title or Company field and use the accompanying text box
to indicate what type of field or fields are likely to contain an ampersand.

“C” indicates a company name, “D” a department or title and “N” a person’s name.
Enter “NC” to indicate that ampersands are found in person names and company
names but not departments or titles. Enter “NNC” to tell Right Fielder that
ampersands are more likely to occur in person names than company names.

5. Check Discard Unindentified Fields and Right Fielder will not write input fields
that it can’t identify as a specific data type to any of the output fields. If not, Right
Fielder places unidentified data according to its best guess. Leaving this
unchecked may require more cleanup after processing but checking it might
discard valuable information (the original data will still be in the input field,
however).
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Check Always Move Last Line To if the last field in each record is always a
specific datatype that requires special handling. For example, it may be that the
last field in each record contains barcode data. You would use this option to tell
Right Fielder to always write this field to an output field called “BARCODE.”

If you are working with a dBase file, you can enter the name for this field and in the
box and this field will be created when Right Fielder processes the file.

If you select an existing field, Right Fielder will automatically enter the size of this
field in characters in the Size box. If you are creating a new field, you must enter a
number greater than zero in this box.

Select a field that Right Fielder will used to write any error codes. If you are
working with a dBase file, you can enter the name for this field and in the box and
this field will be created when Right Fielder processes the file.

You must set an Error field in order to use the Edit... function under the Analyze
menu.

Under Detect Blank Output Fields, check the output field types that you want
Right Fielder to check to see if no data was returned. If these output fields are not
returned, an error code is returned to the Error field. This allows you to flag
records that, for example, do not have a recognizable city, state or ZIP Code.

To finish creating the setup, click OK.

Saving the Setup

To save the setup:

1.
2.

Click the File menu and select Save Setup.

Right Fielder displays the Save Setup dialog. It will suggest the base name of the
selected database as the name for the setup file.

Enter a different name if you do not want to use the suggested name.
Click Save.

Processing the Database

To begin processing a database file, click the Processing... menu. Right Fielder displays
the Processing Options dialog.

1.

2.

By default, Right Fielder writes back the output data as a dBase file. Check End in
ASCII to create a text file as the output file.

To create a backup copy of your original data, check Backup Data.
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3.

7.

Select the Display Mode. Maximum Speed gives priority to processing over
updating the screen, while Scroll displays every record as it is process, at the
expense of processing speed.

Processing Options...

Operations Dizplay Mode
r (* Maximum Speed
[¥ Backup Data " Serol
Record Range
e Al
" Part of File:
- ’— ’—
- [ Q
Help

Check thiz box if you want to make a backup of your database before
proceszing [don't sap we didn't ask!].

o 0K | X cancel | 2 Hep |

Select the Record Range to control which records are processed. Select All to
process every record or choose Part of File to limit the records that Right Fielder
processes.

¢ Record Range — Enter a range of records for Right Fielder to process.

¢ Filter — Enter a dBase express to control which records are processed. Click
the Builder... button to use the Expression Builder to create the expression.
For more information on these advanced features, see the help file.

If you select both Record Range and Filter, Right Fielder will apply the filter to the
selected range of records.

To begin processing, click OK.

After Right Fielder has finished processed, click OK. The program displays the
processing results screen.

{ Processing...

Processing Statistics
Record Mumber: 26 Record Count: 26
Elapzed Time: 000000 Frocessed: 26
Fecords per Hour: 1] Filtered: 1]
Estimated Time:  00:00:00 Errors: 12
FRiight Fielder Error Counts
Elank Field: 7 Guestionable: a
Lost Data: E Fareigrn: 4
Truncation: 1
100%
Slower Faster
? teb |

Click Done to return to the main screen.
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Analyzing Results

To begin analyzing the results of the most recenting processing, click the Analyze menu
and select Edit..

Analyze Right Fielder Errors...

FRiight Fielder Errors

Revigw: Counts  Rewview: Counts
Iv Blark Data 7 | Foreign

¥ Ouestionable 0 ¥ Truncation 1
W' Lost Data [

Uszer Defined Emars

Revigw: Counts

W User-marked

Clear Errors?

Iv Clear erors as you go.

Help

o 0K | X cancel | 2 Hep |

* If you do not want to analyze records with a certain type of error, uncheck that box.

e The Clear Errors as you go option clears the errors from records as you edit
them on the next screen.

Click OK to proceed to the Analyze Edit screen.

Analyze Edit

Input Olutput
1 F1[Joe L Canada 1 MAMET|
2 F2|5603 Brennon Rd 2 NaMEZ|
3 F3 |Baltimare, MD 21215-4307 3 NAME3[
4 F4| 4 “ITLE_DEF1 |
5 F5| 5 “ITLE_DEFZ
& FE| 6 COMPANYT |
7 F7| 7 COMPANY2 |
g Fa| 8  ADDR1|
[ 9 ADDRZ|
[ 4 ADDR3 5603 Brennon Rd
Statistics B CITY |Baltim0re
Current Record: 1 C STATE |MD
Total Records: 26
Remaining Errors: 12 o] ZIP |21 215
Blank Data: 7 E PLUS4 [4307
Questionable: 0
Lost Data: B F COUMTRY |Joe L Canada
Foreign: 4
Truncation: 1 G PHOMET |
H  PHOMEZ|
Error Description
Fareign.
))Eesume | E dit | “Ereviou5| >> Next | LClear Erars | o Close | ? Help
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You can use this screen to perform the following operations:

If a particular field has been misidentified, such as a company field being output to
the name field, click on the current field and drag the data to the correct field.

If you need to alter the contents of any field, click the Edit button. You will then be
able to type in any of the Output fields. While editing, the Edit button will become
the Save button. After making all necessary changes, click the Save button before
proceeding.

To proceed to the next or previous record without clearing the error in the current
record, click the Next or Previous button.

Once you have finished analyzing the current record, click Resume to proceed to
the next record with an error. If Clear Errors as you go as was checked on the
previous screen, any error will cleared from the current record.

To clear the errors from the all records, click Clear Errors.

When you are finished analyzed the current database, click Close.



